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Introduction

1.1

Welcome
Unfair Advantageâ (UA) is a remarkably versatile program. Its
major functions are:
1) Database - Depending upon your subscription category, you
may have access to unparalleled historical scope of world futures
markets reaching back to the 1950s and beyond. Market
categories cover every conceivable commodity product (including
options) and an inventory of stocks, economic series, funds and
indices from the U.S., U.K., Canada and other world financial
markets. Commitments of Traders information is also available
through UA.
2) Updating - This feature adds current market data to the
historical database provided on your initial CD-ROM and stored
on your computer's hard drive. Each update retrieves daily
summary prices on all markets within your subscription category,
which may include any or all of the markets in CSI's vast
database. Intraday updates can be added to your daily Unfair
Advantage charts through the new SnapQuote (SQ) feature,
which retrieves prices from third-party sources.
Downloaded information is distributed to a database file, from
which the other formats are exported for use. Any UA data file
can be made available for charting or other types of analysis.
Updates of the database are handled through the Internet using
your own Web Browser and Internet Service Provider.
Replacement files of historical data are also available online to
protect users from inadvertent data corruption. CSI also
maintains a backup dial-in link for data retrieval with a modem.
© 2004 Commodity Systems, Inc.
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3) Portfolio Management - Unfair Advantage's portfolio system
maintains your favorite charts and exported files. Contracts or
stocks of interest are listed in your choice of multiple portfolios
(directories) so that they can be viewed or accessed instantly.
Your portfolios can be customized to accommodate third-party
software.
4) Charting/Analysis - You'll love the functionality and ease of
Unfair Advantage's charting package. Super-compressed or
vividly detailed charts can be viewed instantly on your ad hoc
choice of markets. Charts may be annotated with text and other
tools such as trend lines and ellipses. This release offers bar and
candlestick charts with volume, open interest and cash. An
expanding list of technical indicators includes COT indicators,
stochastics, moving averages, put/call ratios, spreads, Moving
Average Convergence/Divergence, RSI, At-The-Money Study,
basis and seasonal index studies.
Interpreted Studies allow for custom programming of userdefined indicators, and include an extensive collection of studies
that may be used as-is or modified to meet your individual needs.
Charts may be printed or may be saved as a clipboard image for
pasting into documents.
5) Alternative Analysis - The unique Trading System
Performance EvaluatorÔ (TSPE) can assess your account
funding requirements and your likelihood of experiencing a
profitable performance.
6) UA's MarketScannerÔ tool enables the trader to apply custom
indicators to lists of stocks and futures, and to screen data using
a host of fundamental data. The analyst can capture market
statistics on any of a variety of market groups and then sort and
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filter this data to reveal those that meet a particular criterion. For
example, you might sort the NASDAQ stocks by the six-month
rate of return, or by current RSI values, etc.
7) The Position Manager module reports ongoing valuations for
your various portfolios, even when they contain a combination of
commodities, stocks and funds, and even when the products are
quoted in mixed currencies. Intraday updates (that do not
become part of your CSI database) can be captured from various
third-party websites and used to update valuations throughout
the day for most markets.
8) Programmers can use a built-in API to access all data with
fast, in-memory simplicity.

1.2

Hardware & Communication Requirements
Hardware Requirements
Unfair Advantage is a 32-bit Windowsâ application. It requires:
· Windows NTâ, Windows 98â, Windows MEâ, Windows
2000â or Windows XPâ operating system
· A Pentiumâ-powered PC computer with speeds of 200Mz or
faster
· CD-ROM drive*
· At least 256 MB of RAM
· At least an SVGA monitor
· A mouse or comparable pointing device
· A modem or direct network access
· A minimum of 256 colors desktop setting is required
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· Disk space requirements: Software, 50 MB; Data, 600 MB +
94 MB annual growth (for full database). Futures only, 85 MB
+ 8 MB annual growth; Stocks, 350 MB + 56 MB annual
growth; Options, 165 MB + 30 MB annual growth.
*Some UA software is shipped on CDR disks, which may not be
compatible with certain CD drives. If your drive cannot read the
CD we provide, please contact CSI technical support about
replacement software.
Communication Requirements
· Internet Access is recommended. Broadband service is
suggested for best results.
Microsoft Internet Explorer version 5.0 or higher (for Direct
Internet access).
Other Internet browsers may be used when "Browser" access
is selected.
· Direct-dial (standard phone line with modem) access is
available.
If you do not yet have an Internet connection, you may proceed
with data retrieval through a direct-dial phone call to CSI's host
with your modem. If you plan to use the Internet, now is the time
to order a startup kit from the company of your choice.
The user, NOT CSI, is responsible for all on-line access charges
and/or long-distance phone charges associated with retrieving
data.

© 2004 Commodity Systems, Inc.
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Locked Database & Disk Termination
Unfair Advantage comes to you with a "locked database." This
means that you cannot access the data for charting or analysis
until it is "unlocked." The process of unlocking the database is
simple: First install the database on your hard drive, then collect
a daily update from CSI. This unlocks the database. Please read
on and you will learn how to proceed.
Look at the package in which your Unfair Advantage CD was
supplied. You'll notice that the database expiration date is printed
there. You must install the software and begin updating by this
date.
The Unfair Advantage database must be updated at least once
every month to keep the software working. Failure to update
within a two (2) month span during your current subscription may
result in the temporary loss of license to use the database and
additional expenses. If you allow your database to lapse more
than two months, the database will be corrupted by an
irreparable elapsed-time gap and a replacement CD must be
ordered from CSI and installed. A daily update must then be
downloaded to restore the software's functionality. A fee for costs
will apply.

1.4

Customer Service & Support
CSI offers support for Unfair Advantage users in many ways:
1) Unfair Advantage comes with a QuickStart manual to help you
get up and running quickly.
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2) Unfair Advantage comes with a complete online manual that
you can read from your computer screen as a Help file. To view,
click the Help menu from the main UA menu, and then click
"Help Topics." A pop-up Help window displays with manual text.
Click the [Contents] button for a full listing of the manual content.
You may search for a given topic by clicking the [Index] button
and typing your search key.
Double-click any chapter or topic to reveal its content and use the
scroll arrows at the right side of the window as necessary to view
the full content of your selected topic. If you prefer, you can view
the manual in a larger format (filling your computer screen) by
clicking the square box at the upper right-hand corner of the help
window. This will maximize the help topic. To revert to the
smaller size, click the box again (although it will now have a
double-box appearance).
You'll find many underlined links throughout the online manual,
which are pathways to information on related topics. Click on any
link to read more on that topic. Click [Back] to return to the
previous screen or [>>] to go to the next topic. Click the [Internet]
button to access the CSI website for product information and
support. Future upgrades will utilize the Microsoft "What's this?"
convention for interactive help. Updated digital manuals are often
included in new versions of Unfair Advantage software, which are
posted on the CSI website periodically.
UA also provides automatic links to the manual through its
interactive help feature. To learn about a topic directly from your
UA screen, position your mouse cursor over the desired screen
prompt or menu selection and press the <F1> function key.
3) Current Frequently Asked Questions (with answers) and
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notices are posted on the CSI website at www.csidata.com.
These are located in the Tech Talk column of our monthly
Technical Journals. They often provide a quick solution to simple
problems.
4) Periodic upgrades are made available, usually at no charge,
on our website. Downloading a software upgrade on the CSI
website at www.csidata.com can sometimes solve problems that
have already been discovered and fixed by the CSI software
development team. Each upgrade includes a description of
current capabilities, as well as known problems with the release.
5) Background information is at your fingertips. Unfair
Advantage's Online Factsheets include footnotes that explain
data anomalies that might cause concern. Click "Factsheet" on
the Database menu to answer most questions about historical
data.
6) We offer an e-mail technical support system for questions and
comments. Contact our service staff through the "Email Your
Question" entry on the Help menu (support@csidata.com).
Questions are usually answered the day they are received.
7) Our friendly, knowledgeable technical support staff is available
for telephone support from 8:30 a.m. to 9:30 p.m. (eastern time)
Monday - Friday, except on major holidays. The telephone
number is 1 (561) 392-8663.
Our programming staff strives to identify and correct any error
associated with our software, but we need enough information to
reproduce a problem before we can fix it. Please gather the
information below before contacting customer service about a
possible software error:
© 2004 Commodity Systems, Inc.
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Your User ID
Your Windows Version
Your Unfair Advantage version number
The exact wording of any error message
The name of the active window at the time of the problem
The conditions when the error occurred
A list of steps that led to the problem
A detailed description of what has been tried so far

There is no charge for contacting our service staff, however, we
ask that our customers use CSI support services in the order
presented above, with exceptions as needed for urgent
situations. In this way, we can provide the best service possible
to all our customers, and assure that our staff is available for you
when you need us most.

1.5

Beyond QuickStart
This QuickStart Manual will give you a general understanding of
the installation, updating, charting, portfolios, exporting and
intraday quote capabilities of Unfair Advantage. We hope you
enjoy using the software and will continue exploring the many
program features through hands-on experience and by consulting
the full online reference manual.

For an additional walk-through of program features, click
the "Guided Tour" button on the UA toolbar.

© 2004 Commodity Systems, Inc.
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The Unfair Advantage experience begins with loading the software and
appropriate database on your computer, then follows up with updating
and analysis. Please note that everything supplied on the Unfair
Advantage CD-ROM is compressed and must be installed on your
computer before it can be used. We'll lead you through the process
here.
To begin, simply power up your computer and, with no other programs
running, insert the Unfair Advantage CD-ROM. Most computers are
configured to automatically launch the CD and begin the installation
routine.
If the CD does not launch automatically, you can begin installation as
follows: Click your computer's "Start" button, and then click "My
Computer." Next double-click on your CD drive (probably D:, E:, F: or
G:) The installation will proceed with the selection of the version to
install.
If Unfair Advantage already resides on your hard drive, a "Program
Maintenance" screen will display, offering the options of modifying,
repairing or removing the software. The current version supports using
this feature only to remove a previous version. Assuming your
computer has recently been backed-up to protect you from any
unexpected, but possible problems associated with uninstalling
programs, we recommend you select "Remove" to uninstall your old
Unfair Advantage. Be sure to read and heed the warning about backing
up your computer before clicking the "Delete" button. CSI assumes no
liability for this potentially damaging decision. Once your old UA has
been removed, the program will terminate and you must re-start the
installation procedure from the beginning.

© 2004 Commodity Systems, Inc.
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Selecting the Version to Install
When the Unfair Advantage CD first launches on your computer, the
Install Switch screen displays offering the choices of installing the
current full version, perhaps a Beta Test version, or a Demo version.

Whether you have opened a new account with CSI or are engaging in
a free trial, we recommend you install the default (pre-selected) choice.
The version numbers will slowly progress to higher numbers as the
product matures, functionality improves and features are added.
The Demo Version is comparable to the one available from the CSI
website. It offers limited access to commodity data. Given a choice of
loading a full version or demo version, the full version is almost always
your best choice.
A "Beta" (test) copy of an upcoming version may be available, but
should be selected only by those who are willing to accept and report
unexpected problems. Not recommended for new users!
Click [OK] to proceed with the chosen version.

© 2004 Commodity Systems, Inc.
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License Agreement
The current CSI UA License Agreement and Conditions for Use
displays. Please read this document now. If you accept the agreement
and terms, click the radio button next to "I accept the terms in the
license agreement," and then click [Next] to proceed. If you do not
agree to be bound by the agreement, installation will terminate. The
license agreement may be revised by CSI as time goes by. Please
consult the CSI website periodically to view future agreements.

2.4

Selecting the Installation Directory
UA will proceed with the installation routine as follows:

We strongly recommend using C:\UA (the default) as the drive and
directory. To do so, simply click [Next]. If you have a specific reason to
© 2004 Commodity Systems, Inc.
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store UA in another location, please keep in mind that this program
MUST be stored in its own directory or folder (such as C:\UA), not
directly in the root directory (C:\). You may use any valid drive for
storing the UA software. DO NOT store UA in a directory with other
programs!
Your choice of installation directory becomes important when and if you
ever decide to uninstall Unfair Advantage. The uninstall routine
automatically deletes all programs within the directory selected here.
Installing UA in its own directory also protects all your software from
damage caused by common filenames within the different programs.
Please note that networking is prohibited by the UA License
Agreement.
If you feel you must select another directory, click [Change] and use
the directory tree to navigate to the desired folder. Once selected, that
folder will be shown in place of \ua\ on the above screen. As directed,
click [Next] to store UA in the listed folder.

© 2004 Commodity Systems, Inc.
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Choosing the Database(s) to Install
The next UA installation screen asks you to choose the databases to
install:

This selection refers to the historical data that will be stored on your
computer's hard drive. Although the UA CD holds all history on all
markets, you will only be able to access and maintain the markets that
are installed on your hard drive, and that correspond to your
subscription category from CSI.
You selected your subscription category when you signed up for
service with the CSI Data Retrieval Service. That category was for
retrieval of daily updates of commodities only, stocks and funds only,
or a combination of the two. Also upon subscription, you specified your
preference for receiving or not receiving options data.
It is important to understand that your subscription category controls
not only which files are updated on a daily basis, but also which

© 2004 Commodity Systems, Inc.
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historical data you can access through Unfair Advantage. Please use
care in selecting the appropriate database or databases for installation
so that your choice corresponds with your selected daily update
service.
If you subscribed to CSI for stocks, funds or both, select "Stock
History." Similarly, if you subscribed for commodities only (either
domestic or world), select just "Futures History." For all markets, select
"Both." If options are part of your subscription category, be sure to
check "Option History" by clicking the box. The various databases may
be provided on separate disks. You will be prompted to change disks
as necessary.
Upon selecting the appropriate database(s), click [OK] to proceed.
If you do not install a necessary database, you can return to this
screen later by repeating the installation process, but only within the
first month after receiving the software. After that installation, you'll
need to re-collect daily updates from the date the CD was created (a
time-consuming process). If you wish to install a database more than
one month after the CD was received, you'll need to order a new CD
from CSI. This is necessary because the database you add must be
brought current, which is only practical through a new CD.
If, upon receiving the UA CD-ROM, you decide to install different
databases and change subscription categories, you must notify CSI
before your first daily update. If you are unsure of your subscription
category or wish to make a change, please call the CSI Bookkeeping
Department at 1-561-392-8663. Personal and Private users may
purchase additional years of history at any time. The depth of history
available is controlled by a switch at CSI, so changes in history start
date do not require a new CD. CSI offers different subscription
categories to accommodate the specific needs of our customers. The
subscription categories and their prices are listed on CSI's website at
www.csidata.com.

© 2004 Commodity Systems, Inc.
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Selecting Portfolios
UA allows you to maintain multiple portfolios or export directories, each
of which is a list of normal, computed and/or continuous contracts or
stocks to be followed on a regular basis. They typically hold the nearby
current contracts of several commodities, plus computed contracts
such as adjusted continuous and cash or stocks.
Some software vendors have supplied CSI with portfolio selections that
are compatible with their software. UA will display a list of vendors who
have supplied standardized portfolios as shown:

If you use any of the software systems listed, check the appropriate
boxes by clicking them, and then click [OK]. (Current offerings are
shown in the above example, but more may be added.) When these
portfolios are selected, all necessary market selections, contract
specifications and export formats are automatically handled by the
software.
Depending upon the software program(s) you have selected, if any,
additional customization screens may display. Please complete the
screens as appropriate for your applications. CSI maintains a current
portfolio file for each of the above, (and possibly more) on the CSI
website. These can be downloaded according to vendor instructions.
© 2004 Commodity Systems, Inc.
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Sample Portfolios
If you don't select any of the Vendor portfolios, sample portfolios will be
offered. Sample portfolios are provided to get you started with general
charting and analysis. Feel free to use any or all of the portfolios
provided with your original CD. The Commodity and Stock Samplers
are recommended. The Stock Index Portfolio includes hundreds of
stocks and may be cumbersome.

If you don't select any portfolio from the above choices, UA will be
installed with no initial portfolio. This might be appropriate if you have
saved a portfolio from a previous installation, want to import a portfolio
or if you prefer to enter one or more custom portfolios from scratch.
Don't be too concerned about getting your portfolio exactly right at the
beginning. The one you select can be modified at any time, and you
can add or delete portfolios as needed. Contracts and stocks that are
not in your portfolio can still be viewed through UA.

© 2004 Commodity Systems, Inc.
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Select the portfolio(s) of your choice, then click [OK] to proceed.
The UA files will be copied to your hard drive. You may be asked to
switch disks to accommodate various databases and the copying
process may be lengthy (five to ten minutes). Please wait for UA to
display one final installation message.

2.7

Rebooting UA
A message displays after installation is complete asking you to reboot
your computer:

We have found that rebooting the system at this point greatly reduces
the possibility of software failures, making it well worth the effort. Click
[Yes] to automatically shut down and restart your computer.
Next the InstallShield Wizard will indicate that the installation is
complete. Click [Finish] to exit and the rebooting will commence. Once
your computer is rebooted, you'll be ready to use Unfair Advantage for
the first time.

© 2004 Commodity Systems, Inc.
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You may launch the Unfair Advantage program from your computer's
Start menu as follows:
Click your PC's Start button, then choose All Programs (or Programs).
Move to CSI Unfair Advantage and, finally, click Launch UA, as shown
below:

Either upon initial installation or after several uses, Windows XP and
similar programs will automatically add "Launch UA" to the Start menu.
Once there, you can launch the program by clicking it directly.
You can add "Launch UA" to the Start menu manually by right-clicking
"Launch UA," above, and then clicking "Pin to Start Menu."

© 2004 Commodity Systems, Inc.
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User ID and User Number
The first time you launch Unfair Advantage, the following displays:

Your User ID is a three-letter code and your User Number is a five-digit
number, both of which are printed on a sticker inside the Unfair
Advantage CD package. Enter your User ID, then press the <Tab> key
(not <Enter>) to advance to the User Number box. Type your number,
then click [OK]. You may edit these entries later through Unfair
Advantage Preferences, under General Program Settings - Account.
You are responsible for all accesses on your private account, so be
sure to safeguard your User ID and User Number. They represent the
security measures preventing others from charging data collection
against your CSI account, which is limited to access from a single
computer without incurring additional costs. Because it would be
possible for one user to grant service to an acquaintance by loaning
the installation CD-ROM, this facility protects CSI from unauthorized
service usage.
© 2004 Commodity Systems, Inc.
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Accelerations
When your User ID and User Number are complete, the UA screen
displays with your portfolio at the left and a blank charting screen to the
right. The Main Menu displays across the top. Now you should
customize UA Preferences to assure the fastest downloads and
distributions possible, beginning with your first update. Click
"Preferences" on UA's Main Menu, and then click "Advanced 1" as
shown:

Advanced 1 Recommendations
· Perform distribution in a background thread - Click here so UA
and other programs will operate more smoothly, and with slightly
better performance. (May cause problems for laptops.)
© 2004 Commodity Systems, Inc.
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· Memory Map DB Files when retrieving data - Click here to
improve performance while rewriting files in your portfolio, especially
if you use Windows NT. (Requires at least 15 MB of free memory.)
· When Correcting, keep copy of database in memory - This
feature significantly improves the speed of distribution by storing
temporary information in memory instead of on disk. Free memory
requirements are: 5 MB for futures, 10 MB for stocks, or 60 MB for
options.
· Raise distribution thread priority over foreground tasks - If the
top choice is used (Perform distribution in a background thread), you
can further enhance performance gain through this feature. It will
make your computer less responsive to other programs.
Advanced 2 Recommendations
Next click "Advanced 2," on the UA Preferences screen. It offers four
levels of progressively conservative (and progressively time
consuming) settings, as shown. "Flush writes as files are complete and
employ a log file" is the default selection. It is the second fastest setting
and is a relatively safe and relatively speedy choice.

For faster updates, use the top choice, "Do not flush writes during
© 2004 Commodity Systems, Inc.
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updating." This setting is recommended if speed is a high priority and
regular backups are maintained. Be aware that if a hardware or
software failure occurs during data distribution, most, if not all, of your
UA database will be lost and you will need to restore the full UA system
from your recent backup and then re-collect to bring your database
current. If you want to upgrade speed with this feature, click on the
pointer and drag it up to the top. Click [OK] to proceed.

3.4

Downloading Quotes
Once your desired accelerations have been recorded, you're ready to
download quotes. The required settings for downloading depend upon
your desired method of access. Unfair Advantage is shipped
configured for Internet access. If you are a regular Internet user, you
may be able to quickly get online without any additional customization
as described below. If these instructions are insufficient for your
Internet applications, or if you wish to use Direct Dial or Browser
access, please see the detailed instructions in the full manual, which is
accessible through the Help Menu.
Data Access Times, Frequency & Speed
Before you download, please consider the time of day and recognize
that today's update may not yet be available for all markets. Consider
also that some updates may contain "preliminary data." To see which
markets have been updated for the current day, click the "Database"
menu at the top of the UA screen and then select "View Posting
Status." Only those markets shown with a blue dot have been updated
for the current day.
You may download multiple times throughout the day (on the same
computer) to retrieve additional markets as they become available.
Preliminary stock data may be available as early as 4:45 p.m. E.T. We
recommend that preliminary stock data be verified with a subsequent
"official" update before making trading decisions. You should update at
least once daily to avoid lengthy downloads.

© 2004 Commodity Systems, Inc.
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Each update session retrieves the most recent day and a refurbished
repeat of the previous day. All missing days of trading activity since
your last update (for a period covering up to two months) will also be
included. The transmission can also include error corrections and new
information. Updates of the commodity database typically take no more
than two minutes per day of data. Stock updates take significantly
longer, particularly when collecting Friday's data, as additional
fundamental data is transmitted at that time. The time required for your
first download will depend upon the number of days updated and the
scope of your database. A lengthy data series of a month or more or
involving many market types may take two hours or more.
For Internet access:

With your computer online and the Unfair Advantage screen
displaying, click the "Download New Quotes" icon on the toolbar. It's
the first icon on the left, and resembles a globe. This icon represents
the World Wide Web. The Download/Distribution Selection screen
displays as shown next.

© 2004 Commodity Systems, Inc.
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This screen allows you to download and distribute everything in your
retrieval category or a subset that can be defined through a list. For
your initial retrieval session, simply click [Run] to download and
distribute everything.
Next, the Download Data Communication Settings screen will display
with an "Internet Download" confirmation box superimposed as shown:

Depending upon your communications software, you may have to click
"Connect" or "OK" to initiate a dial-up internet connection, or this may
happen automatically. Either way, once the connection is established,
the "Internet Download" screen will display, but it may be hidden
behind your home page. Feel free to minimize the home page screen
to view the full Unfair Advantage process.
Assuming you entered your User ID and Customer Number correctly
and you have not waited beyond the expiration date on your CD, Unfair
Advantage will bring your full database current.

3.5

Data Distribution
UA proceeds to data distribution after a retrieval session. Data
distribution is the process of appending all the current data received in
your download transmission to the compressed database stored on
your computer's hard drive, as well as writing output files in your
portfolio. It is a necessary step in maintaining a sound database. A
connection to the Internet or a telephone hookup is not needed during
the distribution process. If it is important for you to minimize online
time, you may manually terminate the connection any time after
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distribution has begun. You can arrange for automatic termination of
your Internet connection through the "Distribution 1" screen of General
Program Settings from the UA Preferences menu.
By default, the distribution screen (shown below) chronicles UA's
progress. It shows the date for each day processed (in a 4-digit year,
month and day format) and identifies the actions taken for that day,
starting with your last update and proceeding through to the most
recent day available.
"Applying daily price updates" displays while UA is appending existing
files. If you are downloading stock data, a summary of advancing and
declining issues can also display. Your portfolio(s) will be built from
scratch during your first distribution process, so please allow several
minutes for your initial portfolio build.

The [Cancel] button at the bottom of the distribution screen changes to
[Finish Distribution Later] as the process nears completion. Click either
of these buttons if you absolutely must stop the distribution process. In
either case, you should perform a manual data distribution before your
next retrieval session to avoid an unnecessary download. Note that
distribution will resume at the same spot next time only if [Finish
Distribution Later] is used.
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News Headlines
During distribution, UA takes you to the News Headlines page of CSI's
website. If you are interested in the stories mentioned there, simply
click on the links to view. Click the X at the top right to close this
window.
Error Corrections and Revisions
By default, Unfair Advantage lists all markets that receive corrections
and revisions during data distribution. "Corrections" can include any
data bit that modifies a data file. True corrections are infrequent due to
the rarity of errors in CSI data transmissions. Dividends, stock split
ratios, changes to "Facts of Interest" and changes to the factsheets are
transmitted as "corrections" and will eventually be held in various files
(all ending in .adm), which are located in the UA\Archives directory. In
the future, if you do not wish to view corrections and revisions after
distribution, simply turn the "Display Update Report After Distribution"
feature off through the "Distribution 1" screen in General Program
Settings, from the Preferences menu.
The "Done With Download" message will display:

Click [Close] to clear this message. If you don't want to view it in the
future, click the box next to, "Show me this every time," to remove the
check.
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Navigating Through Unfair Advantage
Once the download and distribution are complete, the full scope of
Unfair Advantage capabilities will be available. Here's a navigation
guide.
Across the top of the screen are topics for pull-down menus, which
constitute UA's Main Menu:

(File, Portfolio, Chart Tools, Database, Trading Tools, Preferences,
Window and Help).
Click on any of these for an additional list of features.
Below the Main Menu is a toolbar that provides an alternate method of
navigating through the software. Each represents a different aspect of
using UA.
From left to right, the first six icons and the last two icons deal with
basic database functions as shown:

Place your cursor (without clicking) over any of the icons to display a
description, then click on your choice. The remaining five icons deal
with charts, and are explained in the next topic.
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On the left side of the UA screen is the Portfolio Manager panel, as
shown:

The "Select Portfolio" box lists the active portfolio (or "All" for all
portfolios), whose content is listed in the panel. The buttons within this
panel are used to add files to the portfolio, edit contract specifications,
display charts and delete portfolio items. The right-hand window of the
Unfair Advantage screen will display charts and tables. These functions
are described next.

3.7

Creating Your First Chart
Click any entry in your portfolio list, and then click the [Chart] button
just above the list to display a chart.

If you don't have a portfolio or you want to chart something that
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isn't in your portfolio, you can create a chart by clicking the chart icon
on the toolbar (third from left). The following screen displays:

As shown above, first you'll select the appropriate "Market Type," and
then either enter or select a symbol. If you have requested a futures
market, you'll need to pick a contract type (such as back adjusted).
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Click [OK] to accept all the default choices for your first sample chart
as shown here:

In our chart example, the title at the top of the chart tells us that this is
a back-adjusted corn contract. This screen shows about a year of data,
but it could easily show the full ten years that were provided with your
subscription. The number of days displayed initially is controlled
through the "Preferences" menu under "Default Zoom Level" in
General Charting Preferences from the Preferences menu. CSI's corn
data goes back to 1949, so "Professional" users and others who
purchased access to additional data can see the long history of corn
trading by scrolling left.
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The main body of the chart (upper portion) displays the trading price,
and the lower window displays volume and, for futures and options,
open interest. The price is interpreted through the vertical scale at the
right.
Chart Properties
If this chart was created from a portfolio listing, you may find out more
about it by viewing the chart Properties. See them by simply rightclicking the source contract or stock on your portfolio list and then
clicking "File Properties" from the menu.
The settings used to create the portfolio item display. They give all
details about the series, including the type of contract (computed or
normal month), the type of adjustment method used for continuous
series, whether or not detrending was used, the date range, chart
periodicity, applicable file formats and more.
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This example tells us that this is a back-adjusted contract, rolling from
one contract to the next based upon changes in open interest. All of
these settings are explained in the Portfolio chapter of the full manual.
Click [OK] or [Cancel] to close.

3.8

Manipulating Your Chart
UA offers a full complement of charting capabilities, as described in the
Charting Chapter of the full manual. These basic functions will get you
acquainted with UA's charts. Use the toolbar above the chart to:

Create a New Chart (not listed in your portfolio).

Zoom Out - This feature compresses the spacing of the price
bars, contracting the data into a smaller, more compact form. Very
contracted charts may have considerable overlap, which tends to
obscure pricing details and studies. Check the calendar at the bottom
of the chart to see the date range currently displayed and use the scroll
bar to see the rest of the chart.
Zoom In - This reverses the above process, allowing you to see
more details on your chart. Each time you click the button, the chart
itself expands, but the time period visible on the screen gets smaller.

Crosshair - Click this button to add a crosshair pointer to your
screen. Use your mouse to position the pointer anywhere on the chart.
A data window showing complete numerical market data for the
corresponding day also displays. Click the button again to remove the
crosshair and data window.
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Change Indicators - Click this button to add studies to your chart.
Those offered here include: Moving Average Crossover, Stochastic,
MACD and others as shown below. The list can change as you add
and delete studies of your choice. When this menu displays, your chart
window is split into four panes for possible study placement.

To place one of these studies on the active chart, click the study name
in the "Study Toolbar" menu and then click [Apply]. You will be asked
which pane should hold the study, and you may select any of four
panes, which are ordered from top to bottom, with 1 representing the
top pane. You may superimpose the study on your bar chart by
selecting pane 1, or select and empty pane to display the study alone.
Alternately, you may "drag" the study name to the pane of your choice.
The chart will be redrawn with the study using the parameters shown.
You can view and edit these parameters by clicking the [Edit] button
and making changes where appropriate. In the example above,
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"VBScript: BollingerBands (15, 1.5) refers to the Bollinger Bands
algorithm run in Visual Basic.
You can also choose other studies, including those from the Advanced
Studies library by clicking the [Add Study] button and then clicking
[Interpreted] on the "Select Study" screen. This is the gateway for more
analysis tools and user-defined, custom studies as described in the full
manual. Use up to two studies. The chart will redisplay using optimal
spacing when the Study Toolbar is closed.

Chart Tools - Click this button to add a Trendline, Annotation,
Rectangle, Ellipse, Gann Fan (with or without reflection) or to Zoom By
Box or Unzoom Previous Zoom.

Print - Click this button to print your chart or table.
Chart/Table - From the tabs at the bottom of the
screen, select your choice of chart or numerical table to display data.
The table gives access to UA's data editor for manually entering price
changes or additions.
Contract Selector - Use these buttons to scroll
through charts of the items in the selected portfolio. Click the right
button (below chart) to display the next chart on the portfolio list. Click
the left button to go back.
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Windows
You can add charts to your screen by selecting them from the Portfolio
list and clicking [Chart]. Click on the "Window" menu at the top of the
Unfair Advantage screen for a list of choices for your charting window.
It allows you to select the chart to view, rearrange charts or to display
them as tiled or cascaded.
Here is a graphic example of more chart manipulation:
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When the Portfolio Manager panel is minimized (either by dragging the
right edge to the left margin of the screen or by clicking the left-pointing
arrow at the right boundary) the charting window can almost fill the
entire screen:

You can restore the Portfolio Manager panel by clicking the rightpointing arrow at the left edge of your chart.
Additional charting is available through Unfair Advantage's
MarketScanner and Trading System Performance Evaluator (TSPE),
which can be launched through the "Trading Tools" menu. Intraday
charts are also available through Position Manager. Other third-party
software analysis is also possible with data retrieved and maintained
through Unfair Advantage as explained next.
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Viewing with Third-Party Software
Third-party software refers to analysis programs outside of the Unfair
Advantage environment, such as MetaStock, VantagePoint, Delta
Graphics, One Day at a Time, Excel and other analysis or spreadsheet
programs. These third-party programs read data files that have been
exported by Unfair Advantage. Export format files are placed on your
hard drive so that they may be accessed for analysis by your thirdparty programs. Once these files are written, you may exit UA and
perform analysis as directed by the respective software makers.
Unfair Advantage will automatically create and maintain export format
files that are specified in user portfolios. Users of some programs will
have arranged for automated portfolio creation during setup. These
portfolios are customized for export without additional manipulation or
input from you.

UA lets you specify CSI, MS, CSIM, Excel or ASCII format files
for additional contracts and stocks through the "Send to Third-Party
Software" icon on the UA toolbar. You can specify the necessary
export formats and destination directories by clicking the icon and
providing the required information. Unfair Advantage will save your
input for future updates of your export format files. If you need data for
third-party programs, please check their reference manuals or call
support to find out which of UA's formats should be used. ASCII files
are often a good choice for compatibility with multiple analysis
packages.
Please note that MetaStock users should export to the MS format to
assure full compatibility with that program. Due to the complex file
structures of CSI, MS and CSIM formats, you should not attempt to
manipulate these files through Windows. Use the appropriate CSI or
MetaStock-compatible program to move, delete and edit these files.
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Disappearing Unfair Advantage
Some vendors of market analysis programs have arranged through
CSI to include data retrieval with Unfair Advantage as part of their
products. These third-party programs have a menu selection, button or
screen prompt that initiates a CSI download and then automatically and
invisibly uses UA to deliver data and maintain pre-specified portfolios.
With this setup, a CSI subscriber can arrange for updates and install
the UA software, but subsequently use only the third-party analysis
product for daily applications.
If you would like your third-party software to support this CSI service,
please ask the supplier to contact CSI. Our staff will work with them
(free of charge) to facilitate a seamless interface for you.

3.10

Intraday Updates
CSI offers daily update service through the Unfair Advantage software
which provides daily summary quotes after the close of the markets.
CSI does not sell or redistribute real-time information. However UA's
SnapQuote service (on the Database menu and the toolbar) and
Position Manager module (on the Trading Tools menu) direct your
Internet browser to third-party websites from which it may gather
intraday quotes. These real-time or near real-time quotes, which are
typically 20-minute-delay data or ECN only, may be used to track
intraday account equity and help you time market entry and exit points.
These free services are offered on a trial basis. Future availability is
not guaranteed.
We call the intraday update process capturing "external" data, because
this data does not pass through CSI's normal cleaning and clearing
process. CSI makes no claims about the accuracy, timeliness or
completeness of this data. SnapQuote prices are incorporated into UA
as estimated current-day values. When you retrieve a normal daily
update from CSI after the markets close, our high-quality, meticulously
checked data replaces the estimated values.
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Intraday Quote Delays
· U.S. Stocks – real time
· North American Futures – 20-minute delay
· Other markets, including mutual funds - updated with most recent
close price in the CSI daily database
SnapQuote

Unfair Advantage can collect intraday SnapQuotes for your
portfolio (a recent open, high, low, last, and volume data) for the
current day with the click of a button (second from left on the toolbar).
Click the "SnapQuote" button on the UA toolbar to pick up intraday
quotes. The "intraday" box in the Portfolio Manager is used to
determine which markets, if any, will be updated during a SnapQuote
session. You must click the "Intraday" checkbox at the far right side of
the Portfolio Manager for each market you wish to update intraday.
Position Manager
Launch Position Manager by clicking UA's Trading Tools menu and
choosing "Position Manager." An empty spreadsheet will display. If
your UA system already includes portfolios you would like to view
intraday, you may simply import them by clicking Position Manager's
File menu and selecting "Import Trades." Then select "UA Portfolio"
and the desired portfolio from the list that displays.
Each symbol will be added to the Position Manager spreadsheet as in
the following example. If you want more than a watch list, you'll need to
edit the new entries to identify the shares or contracts owned, the "in
price," commission, etc. Only normal (not computed) futures contracts
can be added through the import feature.

© 2004 Commodity Systems, Inc.

Using UA for the First Time

45

Note that the data source is listed at the right side of the screen. Any
time the "Source" is listed as "CSI," the data shown represents the last
closing price stored in your daily UA database, not an intraday quote.
CSI reserves the right to modify the delay values or revert to end-ofday updates for all Position Manager prices should third-party sources
limit or restrict access to intraday information.

Alternately, you can add markets individually by clicking the "Positions"
menu and selecting "Add."

Enter the desired symbols and make any necessary additions. Do not
attempt to add markets by simply typing them into the spreadsheet, as
this will cause a program error. Click the "Settings" menu at the top of
the Position Manager screen and then select "Preferences" so that you
can identify your preferences for Internet updates, units for price
quotes and for account margins.
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A UA portfolio could be defined as a directory designation plus
compatibility settings for the files within the directory.
UA lets you create and store portfolios that list all the contracts, stocks,
options, cash series, COT data sets, etc. that you will be viewing
regularly. Your portfolios should include everything you'll want to see in
chart form through UA or through third-party analysis software in
various formats. By identifying the markets of interest to you in
portfolios, you can save a considerable amount of time and effort in
your daily analysis because everything you need will be immediately
available.
UA lets you control all important parameters used to configure the
contracts or stocks in your portfolios and allows you to review or
change these entries at any time. This feature is particularly useful
when designing your own custom trading system with computed
continuous series. Market analysis based on such contracts should
never involve a data series built with unknown parameters. Unfair
Advantage makes you an active and informed participant in your
market study.
Multiple portfolios are used to group investments and to maintain
separate lists of export format files for use with third-party analysis
programs.
You can add portfolios in either of two ways:
1) Click "Create New Portfolio" from the Portfolio menu or
2) use the "Import Portfolio" feature from the Portfolio menu.
Although the portfolio system lets you store your desired markets for
easy access, it does not limit access of non-portfolio data. You can
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chart and/or write files on anything within your subscription category,
whether or not it is listed in your portfolio(s). Please refer to the
"Customizing Your Portfolio" topic for details on creating and defining a
portfolio.
Portfolio Limitations
The markets available for processing through portfolios and the
software available for analysis may be restricted based upon your
subscription category with CSI.
See your Account Status by placing your cursor at the bottom of the
UA screen (on or adjacent to the CU=x, SU=x box) for details on what
is available to you.
You can find out more by clicking "Preferences" at the top of the UA
screen and then choosing "Access Rights."
The MarketScanner(TM) Alternative
A handy alternative to portfolio selection is UA's MarketScanner, which
can automatically list stocks and commodities for charting or other
analysis. This module allows you to sort and filter tradeables according
to your choice of price, volume or fundamental fluctuation, or on study
results.
MarketScanner is started from Unfair Advantage's Trading Tools
menu. See the MarketScanner chapter of the online manual through
the Help Menu for details. Users of MarketScanner can bypass the
standard portfolio feature, or use MarketScanner to select markets for
inclusion in your portfolios.
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Portfolio Menu & Manager
Your entire portfolio system can be controlled through the Portfolio
menu. Reach this menu by clicking "Portfolio" on the Main menu
(second heading from left).

Please note that for many of the functions listed on this menu, you
must first select a portfolio from the Portfolio Manager panel. Some
features require that both a portfolio and included file be selected. You
will be prompted for these as needed.
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Use the Portfolio Menu to:
Create a New Portfolio (use to make a new list of markets for similar
handling)
Edit Portfolio Settings (set common specifications such as format,
rounding, etc. for everything in the portfolio)
Copy Portfolio Settings to a New Portfolio (to use the same settings
on a different set of markets)
Delete Portfolio and Files (to remove a portfolio listing and all
corresponding files)
Import Portfolio (to add a pre-created list with settings)
Export Portfolio (to export the portfolio listing - currently limited to
printer)
Overwrite With Backup Copy (to replace a portfolio with an earlier
version)
Minimize Portfolio Manager (to reduce the panel to a border at the
left of the screen)
Restore Portfolio Manager (to restore the original screen
presentation)
Maximize Portfolio Manager (to expand the panel to fill the screen)
Insert File/Files (add new series to your new or existing portfolio)
Edit File Settings (change the properties of a portfolio item)
Rewrite File Immediately (write an export file to disk now)
Rewrite File on Next Distribution (write an export file to disk the next
time you distribute daily data to your database)
Delete File and Settings (remove an item from the selected portfolio)
Chart Series (display the selected series as a UA chart using the
portfolio settings)
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Find in Portfolio (use to locate a series on your portfolio list)
Select All (select all portfolio items for next action)
Print File List (to make a hard copy listing of the selected portfolio)
Reset Column Widths and Placement (to return UA to its original
presentation)
Change Format (choose between chart, ASCII, MS, CSIM, CSI and
Excel)
Change Period (make file/chart Daily, Weekly or Monthly intervals)
Enable/Disable Portfolios (to specify which portfolios will be updated)
File Properties (view and edit specifications for the selected item)
The Pop-Up Menu
A very similar menu will display if you click on any item in a portfolio
and then right-click your mouse. Use whichever method is most
convenient for you. The pop-up menu is particularly useful when you
have re-sized the Portfolio Manager panel, as it provides additional
utilities for adjusting the visible columns and for restoring the original
screen presentation.
The Portfolio Manager Panel
The Portfolio Manager panel is found on the left side of your UA
screen. The visible portfolio is named in the "Select Portfolio" box at
the top of the panel. Click the down arrow at the right of the "Select
Portfolio" text box to display a menu of all available portfolios. The "All"
option is always at the top of the list. Selecting it will produce a listing of
all portfolios simultaneously, as shown in the following example.
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Portfolio Manager Panel Buttons
· [Add file to portfolio] lets you add a new market as explained in the
"Customizing Your Portfolio" chapter.
· [Find] lets you enter a search string to locate a market in your
portfolio listing.
· [Edit] lets you change the properties of the selected file.
· [Chart] lets you graphically view the selected market, along with any
desired studies. This is also used for viewing tabular data and allows
access to UA's data editor.
· [Delete] lets you remove the selected market from your portfolio list,
and associated files from your computer.
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Expanding/Minimizing Portfolio Manager
Click the small right-pointing arrow on the divider between your chart
and the Portfolio Manager panel to remove your chart from view and
expand the Portfolio Manager panel so that it fills the screen. This will
reveal more details about the content of your portfolio(s).

Note that you can scroll through the many entries using both side and
bottom scroll bars, and can change the column sizes by dragging the
heading dividers to the desired location. The columns can be used to
sort your portfolio as desired. Just click any heading to use it as a sort
key.
Click the small left-pointing arrow at the right border of the expanded
Portfolio Manager panel to restore the chart to your screen. Once the

© 2004 Commodity Systems, Inc.

54

Unfair Advantage QuickStart Manual

original screen presentation is restored, you can further minimize the
Portfolio Manager panel by clicking the left-pointing arrow again.
Right-click your mouse in the Portfolio Panel for a menu of additional
functions, including "Minimize Portfolio Manager," "Restore Portfolio
Manager," "Maximize Portfolio Manager" and "Hide Column."

4.3

Customizing Your Portfolio
To create a new portfolio, click the "Portfolio" menu at the top in the UA
screen, and then click "Create New Portfolio." This produces the
screen below:
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Name: The first thing you'll do is name your portfolio. Simply type a
description or whatever name you prefer into the "Name" text box. (We
used "MyStocks" in the example.)
Directory: As you type the portfolio name, you'll notice that a
corresponding directory name is being inserted into the "Directory" text
box below. The directory specified there will be the physical location of
all files in your new portfolio. The default location is a directory whose
name matches the portfolio name within the C:\UA\Files subdirectory. If
you prefer to store this data in another directory, simply edit the
directory name.
UA will automatically create the directory if it does not already exist.
Another option is to click the [Browse] button and navigate to the
existing directory of your choice. If no directory is selected, the content
of the portfolio will be immediately available for charting with UA, but
will NOT be written to files for use with other programs.
Initial Portfolio Settings
Below the Name and Directory entries, the main body of the portfolio
creation screen shows a series of tabbed pages where you can specify
your desired portfolio settings. They allow you to choose settings that
are tailored to each of your applications.
Portfolio settings are identified during creation, and may be adjusted
later through the "Edit Portfolio Settings" feature on the Portfolio menu.
Click the tabs to see the default selections for each setting and adjust
as desired.
Click [OK] when you have viewed and adjusted the settings for this
portfolio.
Once your new portfolio settings have been arranged, a screen for
selecting the commodities, stocks, indices and options to be included in
this portfolio displays as shown next. If this screen looks familiar, that's
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because it is the same one used for viewing chart properties in the
"Using UA for the First Time" chapter.

Click the arrow beside the "Market Type" box to display a menu from
which you may select from Futures, Stocks and Funds or cash series.
Once the Market Type is chosen, you can either type the desired
symbols (separate with a comma and/or a space) in the "Symbols" box
or click the [Mkts] button to display a list as described next.
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Selecting Markets
The market list is actually the Unfair Advantage Factsheet for the
selected market type. (This example is for All Futures, but you can finetune the selection using the "Limit to Market Type" menu at right.)
Scroll through the list and click the check-boxes in the far left column to
select your desired markets. Only select those markets for which you
want the same contract types, such as Nearest Futures, cash, etc.
Click [OK] to proceed.

Contract Selection
Once you have selected your markets, UA returns to the "Selecting
Data Series" screen, which offers many choices for contract selection
as shown earlier. Possibilities for commodities include Normal Pricing,
Individual Futures Group (IFG), Nth Nearest Futures, Back Adjusted,
Cash Contracts, Options, Perpetual Contractâ Data and Gann
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Contracts. Stock choices are more limited, as you'll see. Select your
desired contract type by clicking the appropriate tab. The example
shows the customization screen for Individual Futures Group (IFG),
which is a popular method of following the nearby contracts as
individual (non-combined) delivery months. Please see the full online
manual for more information about the choices offered here.
Click the appropriate tab for the contract of your choice, make
selections as necessary and, after selecting export information
(explained below), click [OK]. Different selection screens display for
stocks, indices, cash series and options. All are described in detail in
the full manual, which you can read through the Help Menu.
Export Directory and Format
At the right side of the file selection screen are the File Export Options.
These apply to the files UA writes to your disk for analysis with thirdparty software. It is not necessary to write files to disk for analysis
through UA or other programs designed specifically to read UA's
compressed files. Most analytical software such as MetaStockâ,
VantagePoint and Omega's TradeStation require customization
through these prompts.
First confirm that the desired portfolio is listed in the box at the top of
the Portfolio Manager panel. Remember that each portfolio has a
corresponding data directory where all files are stored together. If the
correct portfolio is not shown, click the arrow beside the box and
choose from the list of existing portfolios. All of your pre-selected
Portfolio Settings, as arranged when the portfolio was created or
edited, will apply to your new contract or stock.
Next you'll select the desired file format or formats for your data files.
· ASCII format produces text files that are useful for word
processing and many spreadsheets.
· CSI refers to CSI's QuickTrieveâ format, which is a binary
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format that is popular with many analysis products.
· CSIM is a format that was originally designed to support
MetaStock software. It is compatible with many older MetaStockcompatible programs, but not with the current MetaStock
software.
· MS refers to the MetaStock format. It is created using a DLL
provided to CSI by the makers of MetaStock, and should provide
complete compatibility. (Data in this format should be used only
with MetaStock software.)
· The Excel format is suitable for use in a Microsoft Excel
spreadsheet.
Post Processing
Post processing refers to additional manipulations UA can perform
upon the data while writing export files or displaying charts. These
include detrending, inversion and applying custom studies.
Be sure to complete the left portion of your screen dealing with contract
selection before clicking [OK] to finish the entry.
Once your portfolio is complete and any necessary files are built on
your hard drive, you can select any portfolio item for charting and
analysis through UA or by third-party software.
Portfolio Changes
UA only proceeds to the file selection screen during the initial setup of
a new portfolio. After that, you can add files to the portfolio or change
your current selections through the Portfolio Manager panel or through
other entries on the Portfolio Menu.
For more information on any Unfair Advantage feature,
please consult the full online manual,
which is listed as "Help Topics" on the Help Menu.
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